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ABSTRACT

The present paper focuses on the concepts of hydraulic flood routing model, with time-varying roughness
updating tosimulate flows through natural channels, based on the quasi-steady dynamic wave and full dynamic
wave theory, emphasizing the solving of the intricate Saint Venant’s equation (continuity & momentum
equation). In the later phase of the lecture, a real case study of unsteady flood modelling through HEC-RAS has
been dealt with for a reach (Karad - Kurundwad, chainage 140 km to 260 km) in Krishna river. Lateral inflows
to the main river on the corresponding dates have been considered at Sangam, where tributary Panchganga
contributes to the Krishna flow. The technique provides a reliable initialization of stage/discharge profile for the
flood forecast. The examinations including the initialization of stage profile, conservation of mass, iteration
convergence, Manning’s N, effectiveness evaluation, and convergence with optimum theta (implicit weighing
factor) values are conducted to verify the forecast capability and in validating the model. The forecasting results
show that the stage recalculated by updating the Manning N, in current time has a good agreement with the
observed stage. In addition, GIS RAS mapper procedure has been covered in brief for a flood scenario
conceptualization.

INTRODUCTION

Hydraulic routing employs the full dynamic wave (St. Venant) equations. These are the continuity equation and
the momentum equation, which take the place of the storage-discharge relationship used in hydrologic routing.
The equations describe flood wave propagation with respect to distance and time. Henderson (1966) rewrites the
momentum equation as follows:
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Where,
S¢ = friction slope (frictional forces), in m/m;
S, = channel bed slope (gravity forces), in m/m;
2" term = pressure differential;
3" term = convective acceleration, in m/sec?;
Last term = local acceleration, in m/sec’
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The description of each term:
A(.V/.X) = prism storage
VB(.y/.x) = wedge storage
B(.y/.x) = rate of rise

Q = lateral inflow



The full dynamic wave equations are considered to be the most accurate solution to unsteady, one dimensional
flow, but are based on the following assumptions used to derive the equations (Henderson, 1966):

1. Velocity is constant and the water surface is horizontal across any channel section.

2. Flows are gradually varied with hydrostatic pressure prevailing such that vertical acceleration can be
neglected.

3. No lateral circulation occurs.
4. Channel boundaries are considered fixed and therefore not susceptible to erosion or deposition.

5. Water density is uniform and flow resistance can be described by empirical formulae (Manning, Chezy)
Solution to the dynamic wave equations can be divided into two categories: approximations of the full dynamic
wave equations, and the complete solution.

The three most common approximations or simplifications to the full dynamic equations are referred to as
Kinematic, Diffusion, and Quasi-steady models. They assume certain terms of the momentum equation can be
neglected due to their relative orders of magnitude. The full momentum equation is
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Kinematic and diffusion models have found wide application and acceptance in the engineering community
(Bedient and Huber, 1988). This acceptance can be attributed to their application to mild and steep slopes with
slow rising flood waves (Ponce et al., 1978). Henderson (1966) supported this by computing values for each
term in the momentum equation. It was found that the last three terms of the momentum equation are two orders
of magnitude less than the channel bed slope value and therefore are negligible for steep slopes.

Quasi-Steady Dynamic Wave Routing
Description

The quasi-steady dynamic wave approximation method incorporates the convective acceleration term but not the
local acceleration term, as indicated below:
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In channel routing calculations, the convective acceleration term and local acceleration term are opposite in sign
and thus tend to negate each other. If only one term is used, an error result which is greater in magnitude than
the error created if both terms were excluded (Brunner, 1992). Therefore, the quasi-steady approximation is not
used in channel routing.

Fully Dynamic Wave Routing
Description

Complete hydraulic models solve the full Saint Venant equations simultaneously for unsteady flow along the
length of a channel. They provide the most accurate solutions available for calculating an outflow hydrograph
while considering the effects of channel storage and wave shape (Bedient and Huber, 1988). The models are
categorized by their numerical solution schemes which include characteristic, finite difference, and finite
element methods.

Characteristic methods were used for early numerical flood routing solutions based on the characteristic form of
the governing equations. The two partial differential equations are replaced with four ordinary differential
equations and solved along the characteristic curves (Henderson, 1966). The four equations are commonly
solved using explicit or implicit finite difference techniques (Amein, 1966; Liggett and Woolhiser, 1967,
Baltzer and Lai, 1968; Ellis, 1970; Strelkoff, 1970). Bedient and Huber (1988) state that characteristic methods
incorporate cumbersome interpolations with no added accuracy compared to the finite difference techniques.

The finite difference method describes each point on a finite grid by the two partial differential equations and
solves them using either an explicit or implicit numerical solution technique. Explicit methods solve the
equations point by point in space and time along one time line until all the unknowns are evaluated then advance
to the next time line (Fread, 1985). Much research has been performed on this topic (Garrison et al., 1969;
Liggett and Woolhiser, 1967). Implicit methods simultaneously solve the set of equations for all points along a
time line and then proceed to the next time line (Liggett and Cunge, 1975). Again, this topic has been well



researched by Amein and Chu (1975), Amein and Fang (1970), and Fread (1973a and 1973b), among others.
The implicit method has fewer stability problems and can use larger time steps than the explicit method. Finite
element methods can be used to solve the Saint Venant equations (Cooley and Mom, 1976). The method is
commonly applied to two-dimensional models.

Assumptions

The assumptions given above for all hydraulic models (one-dimensional flow, fixed channel, constant density,
and resistance described by empirical coefficients) apply to dynamic routing. It is also assumed that the cross
sections used in the model fully describe the river’s geometry, storage, and flow resistance.

Limitations

The major drawback to fully dynamic routing models is that they are time-consuming and data intensive, and
the numerical solutions often fail to converge when rapid changes (in time or space) are being modeled. This
can be addressed by adjusting the time and distance steps used in the model; sometimes, however, memory or
computational time limits the number of time and distance steps that may be used. Additionally, fully dynamic
one-dimensional routing models do not describe situations (such as lakes and major confluences) where lateral
velocities and forces are important.

Data Requirements

The accuracy of the model depends on the detail and accuracy of the river geometry that is input to the model
(as well as the choice of appropriate time and distance steps). Input data for each cross section must describe
channel slope and geometry; over bank storage; natural and man-made constrictions (such as bridges); channel
and over bank roughness coefficients, and lateral inflows or outflows. In addition each model needs upstream
and downstream “boundary conditions” — usually a flow hydrograph at the upstream end and some form of
stage-discharge relationship at the downstream end.

Development of Equations

Dynamic routing models use finite-difference versions of the full St. Venant equations. This produces a set of
simultaneous equations for each distance and time step, which are solved by a variety of techniques in different
models.

Use and Estimation of Parameters

The hydraulic input data needed in a dynamic routing model is usually determined from a topographic map or
surveyed river/valley cross sections. Any other special hydraulic conditions (u/s, d/s, or internal boundary
conditions such as dams or waterfalls) must also be identified and described as a rating curve or fixed stage or
flow hydrograph. The selection of computational time and distance steps is critical to the accurate solution of
the equations and to the numerical stability of the solution technique. A commonly cited guideline is that the
wave celerity ¢ should be greater than the ratio of model distance step to time step.

MODELLING WITH HEC-RAS

HEC-RAS is based on the U.S. Army Corps of Engineers’ water surface profile model used for modeling both
steady and unsteady, one-dimensional, gradually varied flow in both natural and man-made river channels. It
also allows sediment transport/mobile bed computations and water quality modeling. The capabilities of RAS
are:

= Steady and unsteady flow modeling

=  Mixed flow regime analysis, allowing analysis of both subcritical and supercritical flow regimes in a
single computer run

= Bridge and culvert analysis and design, including culvert routines for elliptical, arch, and semi-circular
culverts

= Multiple bridge and culvert openings of different types and sizes at a roadway crossing
= Bridge scour computations

= Bridge design editor and graphical cross section editor

=  Floodplain and floodway encroachment modeling

= Multiple profile computations

= Lateral flow, split flow, over bank dendritic networks



= Sediment Transport/Movable Bed Modeling

= Sediment Impact Analysis Methods (SIAM)

= Water Quality Capabilities (Temperature Modeling)
= Tidal boundary conditions

= Reservoir and spillway analysis

=  Levee overtopping

= User Defined Rules for Controlling Gate Operations
= Pumping of flooded areas

= Modeling Pressurized Pipe Flow

= Geometric model schematic can be placed over background maps and incorporate clickable scanned
images of structures

= Inline weirs and gated spillways analysis, including both radial and sluice type gates and Ogee, broad
and sharp crested weirs

= Tributary/diversion flow network capabilities, allowing for fully looped river system analysis in which
reaches can be subdivided and combined

= Quasi 2-D velocity distributions
= X-Y-Z (pseudo 3-D) graphics of the river system
Theoretical Calculations for One-dimensional Flow

The following paragraphs describe the methodologies used in performing the 1-D flow calculations within
HEC-RAS. The basic equations are presented along with discussions of the various terms. Solution schemes
for the various equations are described. Discussions are provided as to how the equations should be applied, as
well as applicable limitations.

+ Steady Flow Water Surface Profiles
+ Unsteady Flow Routing
Steady Flow Water Surface Profiles

HEC-RAS is currently capable of performing one-dimensional water surface profile calculations for steady
gradually varied flow in natural or constructed channels. Subcritical, supercritical, and mixed flow regime water
surface profiles can be calculated. Topics discussed in this section include: equations for basic profile
calculations; cross section subdivision for conveyance calculations; composite Manning's n for the main
channel; velocity weighting coefficient alpha; friction loss evaluation; contraction and expansion losses;
computational procedure; critical depth determination; applications of the momentum equation; and limitations
of the steady flow model. Figure- 1 depicts the terms of the energy equation representation.

Equations for Basic Profile Calculations

Water surface profiles are computed from one cross section to the next by solving the Energy equation with an
iterative procedure called the standard step method. The Energy equation is written as follows:
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Z, Z,= elevation of the main channel inverts

Y, Y,= depth of water at cross sections

V1,V,= average velocities (total discharge/ total flow area)
a;,a,= velocity weighting coefficients

g = gravitational acceleration, h,=energy head loss
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The energy loss term he in €quation 1 is composed of friction loss h¢ and form loss h,. Only contraction and

expansion losses are considered in the geometric form loss term.
he=h¢ + h, @

To approximate the transverse distribution of flow of the river is divided into strips having similar hydraulic
properties in the direction of flow. Each cross section is sub divided into portions that are referred to as
subsections. Friction loss is calculated as shown below:
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A A= downstream and upstream area, respectively of the cross sectional flow normal to the
flow direction
J = total number of subsections
L; = length of the j" strip between subsections
n = Manning’s roughness coefficient
Q = water discharge
Ri,Ry= down stream and upstream hydraulic radius

Other losses

Energy losses due to contractions and expansions are computed by the following equation:
|052V22 051\/12 |
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Where, C, = loss coefficient for contraction and expansion. If the quantity within the absolute value notation is
negative, flow is contracting, C, is the coefficient for contraction; if is positive, flow is expanding and C, is the
coefficient of expansion. In the standard step method for water surface profile computations, calculations
proceed from the d/s to u/s based upon the reach’s downstream boundary conditions and starting water surface
elevation.

hy =C, 5)

Methodology

The primary thrust of this exercise is to introduce you to channel flow using the HEC River Analysis System
(HEC-RAS). By the end of this exercise, you should be able to:

e Import and edit cross-sectional geometry data

e  Perform a unsteady flow simulation for flood forecasting



e View and analyze HEC-RAS output and use GIS RAS mapper for flood delineation.

HEC-RAS Hydraulics

HEC-RAS is a one-dimensional flow hydraulic model designed to aid hydraulic engineers in channel flow
analysis and floodplain determination. The results of the model can be applied in floodplain management studies.
If you recall from hydraulics, unsteady flow describes conditions in which depth and velocity at a given channel
location changes with time. Gradually varied flow is characterized by minor changes in water depth and velocity
from cross-section to cross-section. The primary procedure used by HEC-RAS to compute water surface profiles
assumes a steady, gradually varied flow scenario, and is called the direct step method. The basic computational
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procedure is based on an iterative solution of the energy equation: H =7 +Y + (Figure 2), which

states that the total energy (H) at any given location along the stream is the sum of potential energy (Z + Y) and
kinetic energy (V/2g). The change in energy between two cross-sections is called head loss (h, ). The energy
equation parameters are illustrated in the following graphic:

Given the flow and water surface elevation at one cross-section, the goal of the direct step method is to compute
the water surface elevation at the adjacent cross-section. Whether the computations proceed from upstream to
downstream or vice versa, depend on the flow regime. The dimensionless Froude number (Fr) is used to
characterize flow regime, where:

e Fr<1denotes Subcritical flow
e Fr> 1 denotes Supercritical flow

e Fr=1 denotes Critical flow
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For a subcritical flow scenario, which is very common in natural and man-made channels, direct step
computations would begin at the downstream end of the reach, and progress upstream between adjacent cross-
sections. For supercritical flow, the computations would begin at the upstream end of the reach and proceed
downstream.

Starting a Project
Start the HEC-RAS 4.1.0 program. The following window should subsequently appear (Figure 3):
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Figure- 3

Henceforth, this window will be referred to as the main project window. A Project in RAS refers to all of the
data sets associated with a particular river system. To define a new project, select File/New Project to bring up
the main project window (Figure 4):
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You first need to select your working directory, and then a title (say Karad_FF), and file name (Karad_FF.prj).
All project filenames for HEC-RAS are assigned the extension ".prj". Click on the OK button and a window
will open confirming the information you just entered. Again click the OK button. The project line in your main
project window should now be filled in. The Project Description line at the bottom of the main project window
allows you to type a detailed name for the actual short Project name. If desired, you may click on the ellipsis to
the right of the Description bar, and additional space for you to type a lengthy Description will appear. Any
time you see an ellipsis in a window in HEC-RAS, it means you may access additional space for writing
descriptive text.

For each HEC-RAS project, there are three required components-

Geometry data- The Geometry data, for instance, consists of a description of the size, shape, and connectivity
of stream cross-sections.

Flow data- Flow data contains discharge rates.

Plan data- Plan data contains information pertinent to the run specifications of the model, including a
description of the flow regime.

Each of these components is explored below individually. The schematic picture in Figure 5 depicts the Krishna
-Koyna river confluence at Karad and we will be analyzing a reach Karad - Kurundwad.
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Figure 5

Importing and Editing Geometric Data

The first of the components we will consider is the channel geometry. To analyze stream flow, HEC-RAS
represents a stream channel and floodplain as a series of cross-sections along the channel. To create our
geometric model, we can do it by three ways.

i) From HMS DSS files
i) From Geo-RAS (derived from DEM/TIN)
iii) By manual entry of Geometric data

This HEC-RAS geometry file contains physical parameters describing cross-sections. To view the data,
select Edit/Geometric Data from the project window. The cross sections of Krishna are obtained from
Upper Krishna Division topographic survey record.
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The resulting view shows a schematic of Krishna & its tributary Koyna river with the area of study. This is the
main geometric data editing window. The red tick marks and corresponding numbers denote individual cross-
sections. Choices under the View menu provide for zoom and pan tools. The six buttons on the left side of the

River
Fieach Junct,
screen are used to input and edit geometric data. The ==——and - @ buttons are used to create the reach

schematic. A reach is simply a subsection of a river, and a junction occurs at the confluence of two rivers. Since
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Figure 7

The data used to describe the cross-sections include the river station/XS number, lateral and elevation
coordinates for each terrain point (station & elevation columns), Manning's roughness coefficients (n) (Table 1),
reach lengths between adjacent cross-sections, left and right bank station, and channel contraction and
expansion coefficients (here 0.1 & 0.3 have been taken for smooth transitions) (refer page 87 of Ref Manual).
These data are obtained by field surveys.

X-section No & Manning’s N (as from computed
Name from discharge)
10-Karad 0.033
7-Narasingpur 0.033
6-Khed 0.032
5-Arjunwad 0.031
1-Kurundwad 0.054

Table 1



The m @buttons can be used to toggle between different cross-sections. To edit data, simply double-click on
the field of interest. You may notice that this action caused all of the data fields to turn red and it enabled the
"Apply Data" button. Whenever you see input data colored red in HEC-RAS, it means that you are in edit
mode. There are two ways to leave the edit mode:

1. Click the "Apply Data" button. The data fields will turn black, indicating you're out of edit mode, and
the data changes are applied.

2. Select Edit/Undo Editing. You'll leave the edit mode without changing any of the data.

3. To actually see what the Kurundwad X-section (Figure 8)looks like, select the Plot/Plot Cross-
Section menu item.
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The cross-section points appear black and bank stations are denoted with red. Manning roughness coefficients

appear across the top of the plot. Again, the mmbuttons can be used to maneuver between different cross-
sections. Any solid black areas occurring in a cross-section represent blocked obstructions. These are areas in
the cross-section through which no flow can occur. Some cross-sections contain green arrows and gray areas.
This symbolism is indicative of the presence of a bridge or culvert. Input data and plots specifically associated
with bridges and culverts can be accessed from the main geometric data editor window by clicking on the
Eru:lg,-fEqu

button. Take a little time to familiarize yourself with the geometric data by flipping through some
different cross-sections and bridges/culverts. When you are finished, return to the geometric editor window and
select File/Save Geometric Data. Return to the main project window using File/Exit Geometry Data Editor.

Importing and Editing Flow Data

Enter the flow editor using Edit/Unsteady Flow Data from the main project window. Instead of importing an
existing HEC-RAS flow file, you can use stream flow output from an HEC-HMS model run.

The coordinates of the cursor (time, flow rate) are displayed in the bottom right corner of the plot. Gridlines can
be shown by invoking the Options/Grid menu item.

The direct step method uses a known water surface elevation (and several hydraulic parameters) to calculate the
water surface elevation at an adjacent cross-section. For a sub-critical flow regime, computations begin at the
d/s end. The present data set corresponds tolst & 2™ July, 2006 flood. (Figure 7). The Flood Hydrograph at
Karad (July 1 & 2, 2006) and Rating Curve at Kurundwad are entered as per the actual available dataset. Click
on the Initial conditions and enter the value of initial flow at Karad. The initial flow of 888.04 m%/s at Karad on



the day 1 at 0100 hrs is put. Click OK. The flood hydrograph and rating curve plots along with data view can be
seen in Figures 10 & 11.

All of the required flow parameters have now been entered into the model. From the file menu, select Save
unsteady Flow Data and save the flow data under the name "Karad flows."
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Click on the button from the unsteady flow data window. HEC-RAS allows the user to set the boundary
conditions and Initial conditions at the points (u/s, d/s or internal locations) or as shown in figure. The
boundary conditions and initial flow conditions are filled in as per the actual data.
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Figure 10

Similarly, enter the values for Kurundwad after clicking on the rating curve button and see the curve by pressing
the Plot data option.
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If you want the rating curve at known site, then you can enter it by clicking on Options> Observed (measured)
data> rating curves (gages)

To leave the flow data editor and return to the HEC-RAS project window, choose File/Exit Flow Data Editor.
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Figure 12

Executing the Model

12



With the geometry and flow files established, select Run/ Unsteady Flow Analysis from the project window.
But before running the model, one final step is required: definition of a plan. The plan specifies the geometry
and flow files to be used in the simulation. To define a plan, select File/New Plan and You'll be subsequently
asked to provide a plan title and a 12 character identifier as depicted in the Figure 13.

s Unsteady Flow Analysis @

File Options Help

- Plan: [Plan 03 Short IDn |Plan 03

|l

= Geometry File : |Karad_inter ﬂ
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Figure 13
To execute the model, ensure that the flow model parameters set properly, and click compute button.
Viewing the Results

There are several methods available with which to view HEC-RAS output, including cross-section profiles,
perspective plots, and data tables. From the project window, select View/Cross-Sections.
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Figure 14

The cross-section view is similar to the one shown when we edited the cross-section data. However, the output
view (Figure 15) also shows the elevation of the total energy head line (shown in the legend as "EG 02Jul2010
0700"), the water surface ("WS 02Jul2010 0700"). As with the cross-section geometry editor, you can use the

mmto scroll to other cross-sections. For a profile of the entire reach, select View/Water Surface Profiles
from the project window.
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Using the Options/Zoom In menu option, you can focus on a particular stretch of reach to see how the water
surface relates to structures in the channel such as bridges. Other available options for graphical display of
output data include plots of velocity distribution (View/Cross-Sections/Options/Velocity Distribution) and
pseudo 3D plots (View/X-Y-Z Perspective Plots). Spend a little time playing around with some of the display
options.

For hydraulic design, it is often useful to know the calculated values of various hydraulic parameters. HEC-RAS
offers numerous options for tabular output data display. From project window, choose View/ Detailed Output
Table. It is to note that the simulated value is 1674.38 m®s against the actual observed value of 1674.34 m*/s at
Kurundwad (Figure 16) (X-section_1)(0800 hrs on 2" July, 20086, i.e, end of simulation period). The simulated
water level is 529.37m against observed value of 529.145 m.
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Figure 16

Additional tabular output data can be accessed from the invoking View/Profile Output Table (Figure 17) from
the main project window. Numerous formats and data types can be viewed by selecting different tables from the
Std. Tables menu.
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The resulting table includes a number of hydraulic parameters, including water surface elevation, head losses,
and cross-sectional area. At the bottom of the window, error and notes (if any) resulting from the steady flow
computations are shown. As you scroll through the cross-sections, take a look at some of the error messages. For
this model, some X-sections have been added as the warning it showed to interpolate cross section.

Stability of the model

The vital factors which affect the model stability and numerical accuracy are:

i) Cross Section Spacing
i) Computation time step
iii) Theta weighting factor
iv) Solution iterations & tolerances

Cross sections should be placed at representative locations to describe the changes in geometry. Additional cross
sections should be added at locations where changes occur in discharge, slope, velocity, and roughness. Cross
sections must also be added at levees, bridges, culverts, and other structures. Bed slope plays an important role
in cross section spacing. Steeper slopes require more cross sections. Streams flowing at high velocities may
require cross sections on the order of 30m or less. Larger uniform rivers with flat slopes may only require cross
sections on the order of 300m or more.

Theta is a weighting applied to the finite difference approximations when solving the unsteady flow equations.
Theoretically Theta can vary from 0.5 to 1.0. However a practical limit is from 0.6 to 1.0. Theta of 1.0 provides
the most stability. Theta of 0.6 provides the most accuracy. The default in RAS is 1.0. Once the model is
developed, reduce theta towards 0.6, as long as the model stays stable. The stability problems are due to:

i) Too large time step.
i) Not enough X-sections
iii) Model goes to critical depth — RAS is limited to subcritical flow for unsteady flow simulations. Bad d/s

boundary condition (i.e. rating curve or slope for normal depth). Bad X- section properties, commonly
caused by: levee options, ineffective flow areas, Manning’s n values, etc.

If this happens, note the simulation time when the program either blew up or first started to oscillate. Turn on
the “Detailed Output for Debugging” option and re-run the program. View the text file that contains the detailed
log output of the computations. Locate the simulation output at the simulation time when the solution first
started to go bad. Find the river station locations that did not meet the solution tolerances. Then check the data
in this general area.

Calibration of the Model

The model can be calibrated by changing the hydraulic parameters. Open Unsteady flow analysis> Options>
Calculation options and tolerances. The theta (implicit weighing factor) value as shown in figure can be
changed from 0.6 to 1 and repeated simulations can be run with changed iterations and Changed Manning’s N to
validate the actual results (Figure 19). Some Manning’s N values have been cited from the literature (Figure



20), but the actual values are to be calibrated to have the model match with the real conditions. (Page 81 of
Reference Manual). You can also set the initial conditions during simulation and write detailed log output for
debugging by clicking options> Output Options as shown in Figure 19. You can check data before execution by
clicking Option> Check data before execution.

The present simulation yielded very fitting results as regards discharge, but the water level difference remained
at 22cms (529.37m simulated against 529.15m obs). The simulated matching results may be because of the
single reach simulation, recent observed X-sections and no other streams joining the reach except at Sangam.
Further, this might have accrued due to the exact observed data input at the X-section points.
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Figure 20 (Source- HEC_RAS Tech Reference Manual)
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